
 

PCAN-OBD-2 Viewer 

User Manual 

Document version 1.1.0 (2021-04-08) 



PCAN-OBD-2 Viewer – User Manual 
 

2 

Relevant Products 

Product Name 

PCAN-OBD-2 Viewer 
 

PCAN® is a registered trademark of PEAK-System Technik GmbH. 
Other product names in this document may be the trademarks or registered trade-
marks of their respective companies. They are not explicitly marked by ™ or ®. 

© 2021 PEAK-System Technik GmbH 
Duplication (copying, printing, or other forms) and the electronic distribution of this 
document is only allowed with explicit permission of PEAK-System Technik GmbH. 
PEAK-System Technik GmbH reserves the right to change technical data without 
prior announcement. The general business conditions and the regulations of the 
license agreement apply. All rights are reserved. 

PEAK-System Technik GmbH 
Otto-Roehm-Strasse 69 
64293 Darmstadt 
Germany 

Phone: +49 6151 8173-20 
Fax: +49 6151 8173-29 

www.peak-system.com 
info@peak-system.com 

Document version 1.1.0 (2021-04-08) 

https://www.peak-system.com/�
mailto:info@peak-system.com�


PCAN-OBD-2 Viewer – User Manual 
 

3 

Contents 

1 Introduction 5 
1.1 Features 5 
1.2 System Requirements 6 
1.3 Scope of Supply 6 

2 Installation 7 

3 Basic Principles of Use 8 
3.1 Browsing OBD-2 Information 8 
3.2 Updating OBD-2 Information 9 
3.3 Viewing Real-Time Graph Data 11 
3.4 Customizing the Real-Time Dashboard 11 
3.5 Exporting OBD-2 Information 13 

4 User Interface 14 
4.1 Main Window 14 
4.2 Menus 15 

4.2.1 File Menu 15 
4.2.2 Edit Menu 15 
4.2.3 OBD-2 Menu 16 
4.2.4 View Menu 16 
4.2.5 Help Menu 17 

4.3 Toolbar 17 
4.4 Status Bar 18 
4.5 Connect Dialog Box 18 

5 OBD-2 Information Views 19 
5.1 Summary 19 
5.2 Diagnostic Trouble Codes 20 
5.3 Freeze Frames 20 



PCAN-OBD-2 Viewer – User Manual 
 

4 

5.4 Test Components 22 
5.5 On-Board Monitoring Test Results 22 
5.6 Sensors 23 
5.7 Real-Time Graph 24 
5.8 Vehicle Information 25 
5.9 Supported Identifiers 25 
5.10 Data Log 26 

6 Additional Information 28 
6.1 PCAN Fundamentals 28 
6.2 Understanding PCAN-OBD-2 30 
 



PCAN-OBD-2 Viewer – User Manual 
 

5 

1 Introduction 

The OBD-2 standard defines the exchange of specific vehicle para-
meters for on-board diagnostics. As part of OBD-2, the ISO 15765-4 
standard describes the CAN bus as a transmission option. 

With the Windows software PCAN-OBD-2 Viewer OBD-2 data can be 
read out from connected control units (ECUs) via the CAN bus for 
presentation and further processing. 

The application was implemented based on the programming inter-
face PCAN-OBD-2 API by PEAK-System and is available free of 
charge for users of PEAK CAN adapters. 

Important note: Use the PCAN-OBD-2 Viewer software on your 
own risk. PEAK-System assumes no liability. 

1.1 Features 

 On-board diagnostics according to the standard OBD-2 (ISO 
15765-4) 

 Physical communication via CAN using a CAN interface of the 
PCAN series 

 Support of all OBD-2 services that can be transmitted with CAN 

 Configurable graphical data representation on analog and digital 
instruments in a virtual cockpit 

 Saving and loading of configurations 

 Display of Diagnostic Trouble Codes (DTCs) and available test 
results 

 Reading of data that is recorded if an error occurs (Freeze 
Frames) 
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 Listing emission-related data. Optional display of individual 
parameters as a graph 

 Exporting graphs and records of the OBD-2 communication 

1.2 System Requirements 

 Windows 10 (32/64-bit) 

 At least 2 GB RAM and 1.5 GHz CPU 

 For the CAN bus connection: PC CAN interface from 
PEAK-System 

1.3 Scope of Supply 

 PCAN-OBD-2 Viewer software 

 Documentation in PDF format 
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2 Installation 

To work with PCAN-OBD-2 Viewer, you first need to establish a 
connection to a PCAN hardware which is connected to the plug of 
an OBD-2 compliant car. It is also possible to communicate with any 
OBD-2 compliant Electronic Control Unit (ECU) connected to a CAN 
bus. 

Do the following to connect the PCAN-OBD-2 Viewer to a PCAN 
hardware: 

1. In the OBD-2 menu, choose the command Connect. 

The Connect to dialog box appears. 

2. In the Connect to dialog box, select the PCAN hardware 
with which you want to establish a connection. 

3. In the Bit rate drop-down list, choose a bit rate or keep 
Auto-Detect. 

4. Confirm with OK. 

5. If an error occurs or the connection cannot be established, 
an error message is shown. 
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3 Basic Principles of Use 

3.1 Browsing OBD-2 Information 

After the PCAN-OBD-2 Viewer has been successfully connected to a 
CAN hardware, all OBD-2 requests are automatically transmitted. 
Once the process is complete, you can select any view to get 
information. 

Note: You can see the current task status on the bottom right 
corner of the application. 

Views can be selected by choosing a command in the View menu, 
or by selecting a tab and a sub-category: 

 The Summary tab presents a dashboard with common 
emission-related data values updated in real-time. 

 The Diagnostic Trouble Code view (under Diagnostics tab) 
displays all Diagnostic Trouble Codes (DTCs): 

• Confirmed Emission-Related DTCs (obtained via OBD 
service $03) 

• Pending DTCs detected during current or last completed 
driving cycle (OBD service $07) 

• Permanent DTCs detected during current or last completed 
driving cycle (OBD service $07) 

 The Freeze Frame view (under Diagnostics tab) lists Powertrain 
Freeze Frame data (OBD service $02). 

 The Test component view (under Diagnostics tab) lists available 
controls of On-Board System, Test or Component (OBD service 
$08). 
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 The On-Board Monitoring Test results view (under Diagnostics 
tab) displays the OBDM test results (OBD service $06). 

 The Sensors view (under Monitoring tab) displays current 
emission-related data values (OBD service $01). 

 The Real-Time Graph view (under Monitoring tab) allows to plot 
current emission-related data values in real-time. 

 The Vehicle Information view (under System information tab) 
lists the vehicle information obtained through OBD service $09. 

 The Supported IDs view (under System information tab) 
summarizes for each known OBD-2 identifier (which identifies a 
specific feature) if it is supported by the vehicle’s ECU(s). 

 The Data Log view (under System information tab) outputs all 
OBD-2 responses. 

3.2 Updating OBD-2 Information 

After the PCAN-OBD-2 Viewer has been successfully connected to a 
CAN hardware, all OBD-2 requests are automatically transmitted. 
You can launch those requests again by choosing the Full OBD-2 
scan via  F5  in the OBD-2 menu. This complete scan does the 
following: 

 Transmits requests to get supported identifiers for each OBD 
service that requires one. You can see the result of this process 
in the Supported IDs view. 

 Transmits requests for each OBD service and each supported 
identifier. The results of this process are stored in different 
views depending on their context. The Data Log view will keep 
track of every response received. 
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It is possible to update specific information only. The refresh 
buttons, present on the different views, will only transmit requests 
related to the current view:  

 The Diagnostic Trouble Code view updates Diagnostic Trouble 
Codes through OBD services $03, $07, $0A (which corresponds 
to “confirmed”, “pending”, and “permanent” emission-related 
DTCs). 

 The Diagnostic Trouble Code view also has a Clear DTCs button 
which will send a request to Clear/Reset Emission Related 
Diagnostic Information. It is also accessible through the OBD-2 
menu via the command Clear DTCs. 

 The Freeze Frames view updates Powertrain Freeze Frame data 
(OBD service $02). 

 The Test component view requests control of On-Board System, 
Test, or Component (OBD service $08). 

 The On-Board Monitoring Test Results view updates the OBDM 
test results (OBD service $06). 

 The Sensors view updates current emission-related data values 
(OBD service $01). 

 The Vehicle Information view updates the vehicle information 
obtained through OBD service $09. 

 The Summary view and Real-Time Graph are updated 
automatically (OBD service $01). 
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3.3 Viewing Real-Time Graph Data 

The real-time graph is only available when the Supported 
Parameter Identifiers are defined.  

Do the following to plot an emission-related data value: 

1. On the View menu, select Real-Time Graph or click on the 
Monitoring tab and then on the Real-Time Graph button on 
the left sidebar. 

2. Select emission-related data: 

• Choose a single Parameter ID (PID) value from the Sensor 
combo box. 

• Select multiple PIDs by clicking on the dots button (…). 
Select one or more values in the dialog box and click on 
the Ok button. 

3. Set the Refresh rate which defines the time in milliseconds 
between each request. 

4. Make sure that the Enable acquisition checkbox is checked. 

Tip: You can use the mouse wheel to zoom in and out and click 
and drag the graph to move the time axis. 

3.4 Customizing the Real-Time Dashboard 

The dashboard on the Summary tab displays common emission-
related data values: 

 Engine Coolant Temperature (PID $05) 

 Vehicle Speed Sensor (PID $0D)  

 Time Since Engine Start (PID $1F) 
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 Calculated LOAD value (PID $04)  

 Engine RPM (PID $0C) 

 Barometric Pressure (PID $33) 

 Fuel Level Input (PID $2F) 

 Intake Air Temperature (PID $0F) 

 Air flow rate from Mass Air Flow sensor (PID $10) 

 Malfunction Indicator Lamp (MIL) Status (PID $01) 

 Distance Traveled while MIL is activated (PID $21) 

 Ambient Air Temperature (PID $46) 

 Control module voltage (PID $42) 

Note: If one of the default Dashboard Parameter ID is not sup-
ported, the gauge or displayed value will be zero by default. 

 

Do the following to customize the dashboard: 

1. Click on the Customize… button. 

The customize dashboard window appears, it displays all 
the dashboard’s components along with a description of 
their positions. 

2. For each component, you can assign an OBD variable by 
selecting one in the variable’s combo box.  

3. When a variable is selected, you can edit its displayed title. 

4. Once your modification is done, click the Ok button. 

In addition, you can save and load dashboard configurations with 
the commands in the File menu. 



PCAN-OBD-2 Viewer – User Manual 
 

13 

3.5 Exporting OBD-2 Information 

Once a full OBD-2 scan is complete, it is possible to export various 
data by clicking one of the following commands in the Edit menu: 

 Export OBD-2 Information opens dialog box for saving the data 
as a CSV file (comma-separated value file). The exported data 
matches each view of the application related to an OBD-2 
service: 

• Diagnostic: DTCs 

• Diagnostic: Freeze Frames 

• Diagnostic: Freeze Frame snapshot 

• Diagnostic: Test components 

• Diagnostic: On-Board Monitoring Test results 

• Monitoring: Sensors 

• System: Vehicle Information 

• System: Supported IDs 

 Export Real-Time graph opens a dialog box for saving the 
current graph. Only the visible part of the graph is saved. 

 Export Data Log opens a dialog box for saving the information 
from the Data Log view as a CSV file (comma-separated value 
file). 
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4 User Interface 

4.1 Main Window 

The PCAN-OBD-2 Viewer main window contains the following 
sections, from top to bottom: 

 Menus 

 Toolbar: The toolbar allows quick access to the most frequently 
used commands. 

 Tabs: The results of a Full OBD-2 scan are arranged on tabs: 

Tab  Description  

Summary Shows a small summary of the OBD-2 connection 
status and a dashboard updated in real-time with the 
vehicle data. 

Diagnostics Regroups information concerning Diagnostic Trouble 
Codes, Controls and Test results. 

Monitoring Displays information about current emission-related 
data values. 

System  
Information 

Regroups information of the vehicle and data log of 
the OBD-2 responses. 

 

 Status Bar: Displays information about the CAN connection and 
the current OBD-2 task. It also displays the status of the real-time 
thread and eventually an error icon. 

Tip: You can change the active tab/view by pressing  Alt  +  1  
to  Alt  +  0 . Each number corresponds to a specific view. 
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4.2 Menus 

4.2.1 File Menu 

Command Symbol Shortcut Description  

Fullscreen none F11 Toggles between full screen and 
window mode. 

Load Dashboard 
Configuration 

none none Loads and applies the configuration 
of a previously exported 
dashboard. 

Save Dashboard 
Configuration 

none none Exports the configuration of the 
current dashboard. 

Exit 
 

Alt+F4 Quits the application. 
 

4.2.2 Edit Menu 

Command Symbol Shortcut Description  

Refresh Diagnostic 
view 

none F11 Updates OBD-2 information 
from the Diagnostic tab. 

Refresh Monitoring 
view 

none none Updates OBD-2 information 
from the Monitoring tab. 

Clear All none none Clears all data. 

Clear Log none none Clears the Data Log view. 

Clear Graph none none Clears the Real-Time Graph 
view. 

Export OBD-2 
Information 

none Ctrl+S Exports current OBD-2 
information. 

Export Real-Time 
Graph 

none Ctrl +Shift +S Exports current real-time 
graph. 

Export Data Log none none Exports the Data Log view. 
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4.2.3 OBD-2 Menu 

Command Symbol Shortcut Description  

Connect 
 

none Opens the connection dialog. 

Disconnect 
 

none Disconnects from a PCAN- 
hardware. 

Reset 
 

none Clears the internal OBD-2 receive 
and transmit queues. 

Clear DTCs none none Makes an OBD-2 request to 
clear/reset Diagnostic Trouble 
Codes. 

Full OBD-2 Scan none F5 Updates every displayed data by 
making requests to every OBD-2 
service. 

Real-Time Requests none Ctrl+P Enables or disables the thread 
handling real-time OBD-2 requests. 

 

4.2.4 View Menu 

Command Symbol Shortcut Description  

Summary none Alt+1 Switches to the Summary view. 

DTCs none Alt+2 Switches to the Diagnostic Trouble  
Code view. 

Freeze Frames none Alt+3 Switches to the Freeze Frames 
view. 

Test 
components 

none Alt+4 Switches to the Test component  
view. 

On-Board 
Monitoring 
results 

none Alt+5 Switches to the On-Board  
Monitoring Test results view. 

Sensors none Alt+6 Switches to the Sensors view. 

Real-Time Graph none Alt+7 Switches to the Real-Time Graph  
view. 

Vehicle 
Information 

none Alt+8 Switches to the Vehicle information 
view. 

Supported OBD-2 
Identifiers 

none Alt+9 Switches to the Supported IDs 
view. 

Data Log none Alt+0 Switches to the Data Log view. 
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4.2.5 Help Menu 

Command Symbol Shortcut Description  

PCAN-OBD-2 Viewer 
Help  

F1 Opens this PDF software 
documentation. 

Automatic check for 
new version 

none none Enables checking for a new version, 
when the software without user 
interaction. An internet connection 
is required.  

Check for new 
version…  

none Checks for a new software version. 
An internet connection is required. 

About… 
 

none Displays information about the  
program, version, and copyright. 

 

4.3 Toolbar 

The Toolbar can be used to quickly access common functions: 

Command Symbol Description Alternative 

Exit 
 

Quits the application. Alt+F4 or File | Exit 

Connect 
 

Opens the connection dialog. OBD-2 | Connect 

Disconnect 
 

Disconnects from a PCAN 
hardware. 

OBD-2 | Disconnect 

Reset 
 

Clears the internal OBD-2 receive 
and transmit queues. 

OBD-2 | Reset 

Help 
 

Opens this PDF software 
documentation. 

Help | PCAN-OBD-
2 Viewer Help 

About… 
 

Displays information about the 
program, version, and copyright. 

Help | About… 
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4.4 Status Bar 

The status bar displays information about the CAN connection and 
the current OBD-2 task. It also displays the status of the real-time 
thread and eventually an error icon: 

 Click on the real-time thread status icon to enable or disable the 
thread. It has the same effect as clicking on the Real-time 
requests menu entry in the OBD-2 menu. 

 If an error occurs during an OBD-2 request, a warning icon is 
displayed. Hover the icon with the mouse cursor to show a 
tooltip that lists the description of the error(s). You can switch to 
the Data Log view to find more information about the errors. 
Double click on the warning icon to remove it. 

4.5 Connect Dialog Box 

After starting the PCAN-OBD-2 Viewer, the Connect dialog box will 
be displayed. To work with the software, you have to establish a 
connection with a PCAN hardware. 

To access the Connect dialog box, select the Connect menu entry in 
the OBD-2 menu or click the button on the toolbar. 

 Available CAN hardware: this list shows all available PCAN 
hardware for establishing a connection. 

 Bit rate: this combo box is used to select the bit rate of the CAN 
bus. Note that only legislated OBD bit rates are available. 

 The Refresh button updates the available CAN hardware list. 
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5 OBD-2 Information Views 

The different results of a Full OBD-2 scan are arranged in tabs that 
can be accessed via the main window and sub views that are 
provided via a side bar on the left of each tab. 

5.1 Summary 

The Summary tab presents a dashboard with common emission-
related data values updated in real-time. 

The summary contains three main sections: 

1. On the top-left corner is a summary of the CAN connection, 
the OBD-2 connection type, the Vehicle Identification 
Number, and the number of Diagnostic Trouble Codes. 

2. The real-time dashboard: This is constantly updated through 
the real-time thread. 

3. The Dashboard Real-Time request lists the same data as the 
dashboard but presented as a list. In case of multiple 
responses for a single request, this list can show the 
different values received (whereas the graphic dashboard 
would only display a single value). 

A Customize button is on the right side of the Dashboard Real-Time 
request section. Click on the Customize button to open the 
Customize Dashboard dialog box. This displays all the dashboard’s 
components along with a description of their positions and lets you 
associate each with an OBD-2 variable. 

See also: 3.4 Customizing the Real-Time Dashboard on page 11. 
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5.2 Diagnostic Trouble Codes 

The Diagnostic Trouble Code view under the Diagnostics tab 
displays all Diagnostic Trouble Codes (DTCs): 

 Confirmed Emission-Related DTCs (obtained via OBD service 
$03), 

 Pending DTCs detected during current or last completed driving 
cycle (obtained via OBD service $07), 

 Permanent DTCs detected during the current or last completed 
driving cycle (obtained via OBD service $07). 

The list contains the following columns: 

 Code is the Diagnostic Trouble Code. 

 System indicates which part of the vehicle is bound to the DTC. 

 Module corresponds to the address of the ECU which responded 
to the OBD request. 

 Manufacturer identifies whether this is a generic or vehicle 
specific value. 

 Description shows information about the DTC. 

The Clear DTCs button emits an OBD request to clear/reset 
emission-related DTCs. 

The Refresh button sends requests to update the list of DTCs. 

5.3 Freeze Frames 

The Freeze Frames view under the Diagnostics tab lists Powertrain 
Freeze Frame data (obtained via OBD service $02). 
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When an emission-related fault occurs, the OBD-2 system stores a 
Diagnostic Trouble Code and records a snapshot of the vehicle ope-
rating parameters to help identifying the problem. This set of values 
is referred as Freeze Frame data. 

The section Freeze Frame Diagnostic Trouble Code lists all the 
Diagnostic Trouble Codes. 

 Frame # is the frame number. 

 Code is the Diagnostic Trouble Code. 

 System indicates which part of the vehicle is bound to the DTC. 

 Module corresponds to the address of the ECU which responded 
to the OBD request. 

 Manufacturer identifies whether this is a generic or vehicle 
specific value. 

 Description shows information about the DTC. 

The section Freeze Frame Sensor Snapshot displays the emission-
related values, stored when the emission-related fault occurred, for 
a single DTC selected in the section Freeze Frame Diagnostic 
Trouble Code. 

 Frame # is the frame number where the snapshot is stored. 

 PID is the Parameter Identifier of the emission-related data. 

 Module corresponds to the address of the ECU which responded 
to the OBD request. 

 Mnemonic of the data. 

 Description shows information about the PID. 

 Value is the actual value of the data. 

 Unit is the unit of the data. 

 Min. is the minimum value for that data. 
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 Max. is the maximum value for that data. 

 Value information shows extra information about the data 
value. 

To update the Freeze Frame Sensor Snapshot list, select a DTC in 
the Freeze Frame Diagnostic Trouble Code list and click on the 
Update snapshot button. 

To refresh the Diagnostic Trouble Codes, click on the Refresh 
button. 

5.4 Test Components 

The Test component view under the Diagnostics tab lists available 
control operations of On-Board System, Test, or Component (OBD 
service $08). 

 TID is the Test Identifier. 

 Module corresponds to the address of the ECU which responded 
to the OBD request. 

 Description shows information about this test. 

 Status indicates whether or not the test can be run. 

To refresh the list, click on the Refresh button. 

5.5 On-Board Monitoring Test Results 

The view On-Board Monitoring Test results under the Diagnostics 
tab displays the OBDM test results (OBD service $06). 
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The following identifiers are displayed: 

 OBDMID is the On-Board Monitoring Identifier. 

 Module corresponds to the address of the ECU which responded 
to the OBD request. 

 Description shows information about the OBDMID. 

 TID is the Test Identifier associated with this result. 

 Value is the result value. 

 Unit is the unit of the value. 

 Min. is the minimum value for that data. 

 Max. is the maximum value for that data. 

To refresh the list, click on the Refresh button. 

5.6 Sensors 

The Sensors view under the Monitoring tab displays current 
emission-related data values (OBD service $01). 

The following identifiers are displayed: 

 PID the Parameter Identifier of the emission-related data. 

 Module corresponds to the address of the ECU which responded 
to the OBD request. 

 Mnemonic of the data. 

 Description shows information about the PID. 

 Value is the actual value of the data. 

 Unit is the unit of the data. 

 Min. is the minimum value for that data.  



PCAN-OBD-2 Viewer – User Manual 
 

24 

 Max. is the maximum value for that data. 

 Value information shows extra information about the data 
value. 

To refresh the whole list, click on the Refresh All button. 

To refresh a specific set of data, select one or more PIDs in the list 
using the  Ctrl  or  Shift  key and click on the Refresh selected PIDs. 

5.7 Real-Time Graph 

The Real-Time Graph view under the Monitoring tab can plot 
emission-related data values in real-time. 

The graph can plot one or multiple values: 

 To display the value(s) of a single Parameter ID, select it in the 
Sensor drop down box. 

 To display multiple values from several PIDs, click on the dots 
button (…) and choose one or more values in the dialog box. 
Click on the Ok button to confirm your selection. 

The Enable acquisition checkbox has the same effect as clicking on 
the Real-Time status icon in the status bar or the command Real-
Time requests in the OBD-2 menu. 

The refresh rate value is shown in milliseconds and corresponds to 
the time between each OBD request. 

Click on the Clear button to reset the graph. 

Click on the Export button to export the real-time graph. This is the 
same command that is available in the Edit menu. 
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5.8 Vehicle Information 

The Vehicle Information view under the System information tab 
lists the vehicle information obtained through OBD service $09. The 
following identifiers and values are displayed: 

 InfoType is the InfoType parameter of the OBD service. 

 Module corresponds to the address of the ECU which responded 
to the OBD request. 

 Mnemonic of the data. 

 Description shows information about the infoType. 

 Value is the actual value of the data. 

To refresh the list, click on the Refresh button. 

5.9 Supported Identifiers 

The Supported IDs view under the System information tab 
summarizes for each known OBD-2 identifier if it is supported by the 
vehicle’s ECU(s). 

The following identifiers are displayed: 

 ID # is the Identifier number in hexadecimal format. 

 Parameter IDs states the number of ECUs which support the ID # 
with OBD service $01. 

 Test IDs states the number of ECUs which support the ID # with 
OBD service $08. 

 OBD Monitor IDs states the number of ECUs which support the 
ID # with OBD service $06. 

 FreezeFrame #0 IDs states the number of ECUs which support 
the ID # with OBD service $02 with the default freeze frame #0. 
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For each supported ID two values will be displayed in the cell: 

 The number of ECUs supporting the identifier for the specified 
OBD service. 

 A bit encoded value which represents exactly which ECUs 
support the ID. The value is written in a binary format where the 
rightmost digit corresponds to the ECU #1. 

5.10 Data Log 

The Data Log view under the System information tab lists each 
OBD-2 response. 

 Each result for a request is grouped. The group title is made of: 

• OBD service ID of the request. 

• Parameters associated to the request. 

• Status of the transmitted request. 

 Service defines which OBD service was requested. 

 Parameter displays the parameters which were associated with 
the request. 

 Source states the address of the ECU which responded to the 
request. 

 Error code indicates the OBD status code of the response. 

 Data shows the parsed data of the response. Depending on the 
service request, the data is parsed differently. 

 Raw data displays the received CAN frame without parsing. 

If an OBD request returns a non-Ok status all the responses are 
highlighted in orange-red. The responses are not parsed but their 
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raw data is still available. This can happen for example if a request 
is not supported or if an unknown/unlegislated PID is requested. 

If an OBD response contains a non-Ok error code, the status value is 
highlighted in red. 

To clear the list, click on the Clear button. 

To log real-time requests, make sure that the Log real-time requests 
checkbox is active. 



PCAN-OBD-2 Viewer – User Manual 
 

28 

6 Additional Information 

6.1 PCAN Fundamentals 

PCAN is a synonym for PEAK CAN APPLICATIONS and is a flexible 
system for planning, developing, and using a CAN bus system. 
Developers as well as end-users get a helpful and powerful product. 

Basis for the communication between PCs and external hardware 
via CAN is a series of Windows Kernel Mode Drivers (Virtual Device 
Drivers) e.g., PCAN_USB.SYS, PCAN_PCI.SYS, PCAN_xxx.SYS. 
These drivers are the core of a complete CAN environment on a PC 
running Windows and work as interfaces between CAN software 
and PC-based CAN hardware. The drivers manage the entire data 
flow of every CAN device connected to the PC. 

A user or administrator of a CAN installation gets access via the 
PCAN-Clients (short: Clients). Several parameters of processes can 
be visualized and changed with their help. The drivers allow the 
connection of several Clients at the same time. 

Furthermore, several hardware components based on the SJA1000 
CAN controller are supported by a PCAN driver. So-called Nets 
provide the logical structure for CAN buses, which are virtually 
extended into the PC. On the hardware side, several Clients can be 
connected, too. The following figures demonstrate different possi-
bilities of Net configurations (also realizable at the same time). 
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Figure 1: Different possibilities of Net configurations 

Following rules apply to PCAN-Clients, Nets, and hardware: 

 One Client can be connected to several Nets. 

 One Net provides several Clients. 

 One piece of hardware belongs to one Net. 

 One Net can include none or one piece of hardware. 
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 A message from a transmitting Client is carried on to every 
other connected Client, and to the external bus via the 
connected CAN hardware. 

 A message received by the CAN hardware is received by every 
connected Client. However, Clients react only on those 
messages that pass their acceptance filter. 

Users of the PCAN-OBD-2 Viewer do not have to define and manage 
Nets. If the PCAN-OBD-2 Viewer is instructed to connect directly to a 
PCAN hardware, the application automatically creates a Net for the 
selected hardware and automatically establishes a connection with 
this Net. 

6.2 Understanding PCAN-OBD-2 

OBD-2 stands for On-Board Diagnostics. It is a standard that speci-
fies the type of a diagnostic connector and its pinout, the electrical 
signaling protocols available, the messaging format and a candidate 
list of vehicle parameters to monitor along with information how to 
encode the data for each. 

The OBD communication protocol is defined in SAE J1979 / ISO 
15031-5 and the specific implementation for CAN bus is described in 
ISO 15765-4. It is a Client/Server oriented protocol: 

 External test equipment has the role of the client 

 Electronic Control Units (ECUs) connected inside the vehicle are 
servers 

Note: There are five signaling protocols that are permitted with 
the OBD-2 interface. PCAN-OBD-2 is only valid with ISO 15765 
CAN signals. PCAN-OBD-2 is the collection of the following 
standards: ISO 15765-4, ISO 15765-3 (known as Diagnostic/UDS 
on CAN), and ISO 15765-2 (known as ISO-TP). 
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The client always starts the communication by sending a request. If 
a server supports this request, it will reply with a positive or nega-
tive response. Otherwise, it can just ignore the request. As the client 
cannot choose which server replies to its request and the request 
can be supported by multiple servers, the client should be aware of 
receiving more than one response to a request.  

Since the transport protocol of OBD-2 on CAN is done using ISO-TP, 
an international standard for sending data packets over a CAN bus, 
the maximum data length that can be transmitted in a single data-
block is 4095 bytes. 

The PCAN-OBD-2 API is an implementation of the OBD-2 on CAN 
standard. The physical communication is carried out by PCAN 
hardware (PCAN-USB, PCAN-PCI etc.) through the PCAN-UDS, 
PCAN-ISO-TP, and PCAN-Basic API (free CAN APIs from PEAK-
System). Because of this, it is necessary to have also the PCAN-
UDS, PCAN-ISO-TP, and PCAN-Basic APIs (PCAN-UDS.dll, PCAN-
ISO-TP.dll, and PCANBasic.dll) present on the working computer 
where PCAN-OBD-2 is intended to be used. PCAN-OBD-2, PCAN-
UDS, PCAN-ISO-TP, and PCAN-Basic APIs are free and available for 
all people who acquire a PCAN hardware. 



PCAN-OBD-2 Viewer – User Manual 
 

32 

 
Figure 2: Relationship of the APIs 
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